Waterfall Chart Component for Xcelsius
by Three D Graphics, Inc

(Waterfall Chart Component for Xcelsius)

AUGUST, 2010
NOTICES:

Copyright 2010 by Three D Graphics. All rights reserved. This document may not be reproduced or disclosed in whole or in part by any means without the written consent of Three D Graphics.

Three D Graphics
11340 West Olympic Blvd., #352, Los Angeles, CA. 90064
Telephone: 1.310.231.3330
Fax: 1.310.231.3303
Web: http://www.threedgraphics.com
AUGUST, 2010
# Table of Contents

Waterfall Charts Overview .................................................................................. 1

Three D Graphics Waterfall Chart Component .................................................. 1

Setup Instructions .............................................................................................. 2

Add the Component to an Xcelsius Report ....................................................... 3

Configure the Component .................................................................................. 4

  Properties/Data .............................................................................................. 5
  Properties/Behavior/Common .......................................................................... 7
  Properties/Behavior/Scale ............................................................................. 8
  Properties/Appearance/Colors ....................................................................... 10
  Properties/Appearance/Axes ......................................................................... 11
  Properties/Appearance/Text .......................................................................... 12

Add Components to Interact with the Chart in Run-Time ......................... 14
Waterfall Chart Component for Xcelsius
by Three D Graphics, Inc.

- Beginning Cash: 50.0
- Income: 35
- Expenses: -15
- Plant & Equipment: -12
- Subtotal: 58.0
- Currency Conversion: 2.9
- Ending Cash: 60.9
Waterfall Charts Overview

A Waterfall Chart graphically illustrates the cumulative effect of sequentially introducing positive or negative values to an initial value. It is normally used to visualize how an initial value is affected by a series of intermediate positive or negative values. The initial and final (or total) values are represented by whole columns drawn from the category/X-Axis baseline. Intermediate positive and negative values are drawn as floating columns. The columns are typically color coded to distinguish between positive (green) and negative (red) values.

A Waterfall Chart is also known as a Cascade Chart which is often used in Financial statements as a visual form of cash-flow analysis.

Three D Graphics Waterfall Chart Component

The Three D Graphics Waterfall Chart component is an Xcelsius add-on component that can be used to introduce Waterfall Charts in your Xcelsius reports. In addition to the standard Waterfall Chart functionality, the Three D Graphics component includes:

- Multiple Subtotal risers
- Multiple Intermediate “Other” risers that can be color-coded independent of the green/red positive/negative risers
- By default the Total riser is auto-calculated based on passed-in cells (values). A Custom Total value can be specified to replace the normal automatic calculation.
- Automatic or Manual Y-Axis scaling
- Zero-based or Non-Zero-based Automatic Y-Axis scaling
- Riser Width and Connector Line controls
- Color and Transparency controls for risers, plot area, and chart area
- Drop Shadows on risers
- Color, Transparency, and Width controls for grid lines, ticks, and axis lines
- Data Text Position Controls. The default settings place data text below negative risers, above positive risers, and in the center of total/subtotal risers. These default setting can be changed with the Data Text Position controls.
- Automatic adjustment of data text labels so they are most visible depending on the size of a riser. If a riser is set to "center" and the data text label does not fit, auto-adjust will move the label to above/below the riser.
- Dynamic Visibility: Dynamically show/hide the Waterfall Chart component based on a field in the data set.
Setup Instructions

Download the Waterfall Chart component from the Three D Graphics web site:


The distribution package (.ZIP file) contains the Waterfall Chart component (WaterfallChart.XLX), this document (in .PDF format), and sample Xcelsius report (.XLF) files that use the component.

- Launch Xcelsius.
- Choose “Manage Add-Ons” from the File menu to show the Xcelsius Add-On Manager dialog:

  ![Xcelsius Add-On Manager](image)

  - Click the Install Add-On button and navigate to the folder where the WaterfallChart.xlx file resides.
  - Choose the WaterfallChart.xlx file and click OK.
  - Click Close in the Xcelsius Add-On Manager dialog.

Xcelsius will prompt you to exit and restart the application.
Add the Component to an Xcelsius Report

After you complete the setup instructions, the Waterfall Chart component will be available in the Xcelsius Components menu.

- Launch Xcelsius
- Open an existing Xcelsius project (.xlf) file or choose “New” or “New with Spreadsheet” from the File menu
- Drag the Waterfall Chart component from the Add-Ons section of the Components panel onto your canvas

The component contains default data and labels to draw the Waterfall Chart shown in this illustration.
Configure the Component

The Waterfall Chart Properties panels define the data, behavior, and appearance of the chart:

- **Data**: The Data tab contains properties to define chart titles and data used to draw the risers and labels.
- **Behavior/Common**: The Common tab contains properties to define the width of risers, riser connecting lines, and dynamic visibility.
- **Behavior/Scale**: The Scale tab can be used to define automatic/manual scaling on the Y-Axis.
- **Appearance/Colors**: The Colors tab can be used to define the color of risers, the chart area, and the plot area. Transparency can be applied to each color. Drop shadows can be applied to risers.
- **Appearance/Axes**: The Axes tab can be used to apply color, transparency, and thickness to grid lines.
- **Appearance/Text**: The Text tab contains properties for defining the color and format of text objects. Also includes controls for positioning data text labels.
**Properties/Data**

The Data tab in the properties panel defines chart titles and data that will be used to form the Waterfall chart risers, titles, and labels:

<table>
<thead>
<tr>
<th>Data</th>
<th>Behavior</th>
<th>Appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Titles</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Chart:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Subtitle:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Subtitle</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Category (X) Axis:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Value (Y) Axis:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Data Values:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50,35,-15,-12,47</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Category (X) Labels:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label 1,Label 2,Label 3,Label 4,Label 5~</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Use custom Total Value:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In all of these fields, you can enter information in the associated field or click the data button to choose data from one or more cells in the spreadsheet.

**Chart:** Enter text to draw in the chart title or click the data button to choose the chart title from a cell in the spreadsheet. The Text tab in the Appearance panel can be used to change the color and format of this title.

**Subtitle:** Enter text to draw in the chart subtitle or click the data button to choose the chart subtitle from a cell in the spreadsheet. The Text tab in the Appearance panel can be used to change the color and format of this title.

**Category (X) Axis:** Enter text to draw for the X-Axis title or click the data button to choose the X-Axis title from a cell in the spreadsheet. The X-Axis title is drawn below the category labels at the bottom of the chart. The Text tab in the Appearance panel can be used to change the color and format of this title.

**Value (Y) Axis:** Enter text to draw for the Y-Axis title or click the data button to choose the Y-Axis title from a cell in the spreadsheet. The Y-Axis title is drawn vertically next to the Y-Axis labels on the left side of the chart. The Text tab in the Appearance panel can be used to change the color and format of this title.

**Data Values:** Enter comma separated values or click the data button to choose data values from cells in the spreadsheet. The specified range of values will be
used to form the risers that represent the initial value, positive values, negative values, and subtotal and other values (if identified by Category (X) Axis Labels). The TOTAL riser is **auto-calculated** based on the specified range of values.

**Category (X) Axis Labels:** Enter comma separated text labels to draw on the category/x-axis or click the data button to choose labels from cells in the spreadsheet. If labels are not specified, the default configuration of the component is no label for the first/initial value riser, “Label 2" ... “Label n” for each value specified in the Data Values field, and “Total” for the total riser. If your data set includes a subtotal calculation, add a carat (^) suffix to the “Subtotal” label to draw this riser from the base of category/X-Axis. If your data set includes an additional value to add to the subtotal to form the total riser, add a tilde (~) to the label to identify the additional (other) value. Example:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>Subtotal^</th>
<th>Other~</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>10</td>
<td>-10</td>
<td>5</td>
<td>SUM (A:D)</td>
<td>2</td>
</tr>
</tbody>
</table>

Multiple Subtotal and Other risers may be defined in a data set to appear at any location in the chart. The carat (^) identifies a value to be interpreted as a subtotal (drawn from the baseline). The tilde (~) identifies a value to be interpreted as an Other riser (not color coded red/green). Example:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>Subtotal1^</th>
<th>Other1~</th>
<th>G</th>
<th>Subtotal2^</th>
<th>Other2~</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>10</td>
<td>-10</td>
<td>5</td>
<td>SUM (A:D)</td>
<td>2</td>
<td>20</td>
<td>SUM (E:G)</td>
<td>10</td>
</tr>
</tbody>
</table>
Use Custom Total Value: The TOTAL riser is auto-calculated based on the specified range of values in the Data Values field. This field lets you override that calculation and define the value of the TOTAL riser. Click this checkbox and enter a custom total value or click the data button to choose a value from a cell in the spreadsheet.

Properties/Behavior/Common

This section of the properties panel defines the width of risers, riser connector lines, and dynamic visibility.

Riser Width: Use the slider to adjust the relative width of the risers in the Waterfall chart. At 0%, risers will be invisible. At 100%, risers will be as wide as possible with no connecting lines (i.e., vertical walls of risers are aligned side by side).

Show Riser Connecting Line: Click this check box to enable/disable the connector line between risers.
Dynamic Visibility (Show component only if status matches key): Define Status and Key values to enable dynamic visibility.

Status: Click the button and select a field in the data set that will control the visibility of the Waterfall Chart component.

Key: Enter a value or click the button to define the key value that will cause the component to be visible at run-time.

Properties/Behavior/Scale

This section of the properties panel defines Y-Axis scaling:

- **Manual (Y) Axis**: Click this radio button and enter minimum and maximum values to draw on the Y-Axis.
- **Auto (Y) Axis**: Click this radio button to select automatic non-zero scaling on the Y-Axis. The component will automatically calculate and draw the values needed on the Y-Axis based on the range of values in the data set. Use the **Always Include Zero Line** field if you want automatic scaling to always include zero.
- **Always Include Zero Line**: When Auto (Y) Axis scaling is enabled, click this check box to force automatic scaling to begin at zero. Automatic scaling will only include zero if the range of values in the data set require it. If auto-scaling does not include zero, use this field to force zero-based auto-scaling.
Example: Always Include Zero Line

**Example:** Force Zero Line

**Divisions:** If Manual (Y) Axis is enabled, these fields can be used to specify the number of divisions on the Y-Axis.

**Auto:** Click the Auto button to automatically calculate the number of divisions on the Y-Axis based on the minimum/maximum values.

**Number of Divisions:** Click the Number of Divisions button and enter the number of divisions you want to appear on the Y-Axis.

**Size of Divisions:** Click this button and enter a value to define the increment between each value on the Y-Axis.
**Properties/Appearance/Colors**

This section of the properties panel defines the color of the chart area, plot area, and risers:

<table>
<thead>
<tr>
<th>Data</th>
<th>Behavior</th>
<th>Appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colors</td>
<td>Axes</td>
<td>Text</td>
</tr>
</tbody>
</table>

**Risers**
- **Positive Color**: This color selection will be applied to risers with a positive value.
- **Negative Color**: This color selection will be applied risers with a negative value.
- **Total Color**: This color selection will be applied to the first/initial riser, the subtotal riser (if defined), and the total riser.
- **Other Color**: This color selection will be applied to the riser between the subtotal and total riser.
- **Show Riser Drop Shadows**: Click this check box to apply a shadow to risers.

**Chart Area**
- **Show Fill**: Click this check box and select a color to apply to the chart area outside the plot area.
- **Show Border**: Click this check box and select a color to apply to the outlined edge of the chart area.
- **Chart Area/Show Border/Thickness**: If Show Border is enabled, apply width to the border.

**Plot Area**
- **Show Fill**: Click this check box and select a color to apply to the plot area.

**Positive Color**: This color selection will be applied to risers with a positive value.

**Transparency**: In all of the Transparency fields, 0...100 applies a transparency level to the color (100 = no transparency/solid color, 0 = fully transparent).

**Negative Color**: This color selection will be applied risers with a negative value.

**Total Color**: This color selection will be applied to the first/initial riser, the subtotal riser (if defined), and the total riser.

**Other Color**: This color selection will be applied to the riser between the subtotal and total riser.

**Show Riser Drop Shadows**: Click this check box to apply a shadow to risers.
### Properties/Appearance/Axes

This section of the properties panel defines the appearance of axis and grid lines.

<table>
<thead>
<tr>
<th>Data</th>
<th>Behavior</th>
<th>Appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Colors/Axes/Text

<table>
<thead>
<tr>
<th>Vertical (Y) Axis</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Axis Line</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Major Ticks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Major Gridlines</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Horizontal (X) Axis</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Axis Line</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Major Ticks</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Vertical (Y) Axis/Show Axis Line**: Click this check box and select a color to apply to the Y-Axis base line (the vertical line on the left side of the chart next to Y-Axis labels).

**Transparency**: In all of the Transparency fields, 0...100 applies a transparency level to the color (100 = no transparency/solid color, 0 = fully transparent).

**Thickness**: In all of the Thickness fields, 0...100 defines the thickness of the line.

**Vertical (Y) Axis/Show Major Ticks**: Click this check box and select a color to draw major ticks (lines that poke out from the Y-Axis base line on the left side of the chart).

**Vertical (Y) Axis/Show Major Gridlines**: Click this check box and select a color to draw major grid lines on the Y-Axis.

**Horizontal (X) Axis/Show Axis Line**: Click this check box and select a color to apply to the X-Axis base line (the horizontal line on the bottom of the chart above X-Axis labels).
**Horizontal (X) Axis/Show Major Ticks**: Click this check box and select a color to draw major ticks (lines that poke out from the X-Axis base line on the bottom side of the chart).

**Properties/Appearance/Text**

This section of the properties panel defines the format of titles and labels and the placement of data text labels:

<table>
<thead>
<tr>
<th>Data</th>
<th>Behavior</th>
<th>Appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Colors</td>
<td>Axes</td>
<td>Text</td>
</tr>
<tr>
<td>Show</td>
<td>Text</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Check</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑</td>
<td>Title</td>
</tr>
<tr>
<td>☑</td>
<td>Subtitle</td>
</tr>
<tr>
<td>☑</td>
<td>X Axis</td>
</tr>
<tr>
<td>☑</td>
<td>Y Axis</td>
</tr>
<tr>
<td>☑</td>
<td>Y Axis Title</td>
</tr>
</tbody>
</table>

**Show**: The Show check boxes show/hide titles, axis labels, data text labels, and mouse-over data text labels. When Mouse Over Data Text is checked, the component will show the riser’s X-Axis label, high value, and low value when the mouse hovers over the riser in run-time mode. Example:
Format Selected Text: When a title or label is selected, the Format Selected Text controls define the font, size, color, and format (Bold, Italic, Underline) of the selected text object. Some controls are specific to and will only be available for particular text objects.

These controls are only available for the title and subtitle. They define the alignment of the text within the chart frame: Left, Center, or Right.

These controls are only available for data text labels. They define the alignment of data text labels in the plot area: Above the riser, Center of the Riser, or Below the riser. By default, data text is positioned above positive and other risers, below negative risers, and centered in initial, subtotal, and total risers. These controls can be used to change the default placement of data text. However, note that the component may automatically adjust the placement of data text labels so they are most visible depending on the size of a riser. If a riser is set to "center" (for example) and the data text label does not fit, auto-adjust will move the label to above/below the riser.

Number Format: For numeric labels (including Mouse Over Data Text), select a number format from the list box: General, Numeric, Currency, or Percent. For Numeric format, the following additional controls appear:

For Currency format, the following additional controls are available:
For Percent format, the following additional controls are available:

- **Decimal Places**: Defines the number of decimal places to show for the selected numeric text label.
- **Negative Values**: Defines the format in which to show negative values (-1234.21 or (1234.21).
- **Use 1000 separator**: Click this check box to show values above 1000 with comma separators (e.g., 9,999,999 or 9999999).
- **Currency Symbol**: For currency number format, specify a prefix/suffix character.
- **Prefix/Suffix Symbol**: Check one of these buttons to show the currency symbol as a prefix or suffix.

## Add Components to Interact with the Chart in Run-Time

After you have configured the Waterfall Chart, you may want to add standard Xcelsius components to the canvas that interact with the chart in run time mode. This can be done with a variety of interactive components such as sliders, data grids, spin buttons, etc. The following illustration shows the waterfall chart components in an Xcelsius report where horizontal slider controls have been added to allow the user to modify the Initial Value and Other riser values.
Waterfall Chart Add-On Component for Xcelsius

Waterfall Chart
by Three D Graphics

<table>
<thead>
<tr>
<th></th>
<th>Initial Value</th>
<th>Second</th>
<th>Third</th>
<th>Fourth</th>
<th>Subtotal</th>
<th>Other</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Initial Value</td>
<td>100</td>
<td>10</td>
<td>20</td>
<td>-5</td>
<td>-10</td>
<td>115</td>
</tr>
<tr>
<td>2</td>
<td>First</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>